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What is Spam?  

Spam is the scourge of the Internet. Almost every Internet user receives spam: undesired e-

mail messages selling products and services, messages suggesting that users visit certain 

web sites, often pornographic, and scams of all kinds. Some people get so much spam that 

they spend more time sorting their in-boxes than they do reading legitimate e-mail. 

 

Spam is the electronic equivalent of the junk mail you receive in your mailbox. But while 

much of the junk mail you receive is local—flyers for the neighborhood supermarket, sales 

at your nearest sporting goods store—spam generally presents scams and swindles. Some 

of these include the "Nigerian Scam", or the 419 scam, named after the relevant section of 

the Criminal Code of Nigeria, where e-mails ask you to help someone obtain several 

million dollars from a bank account, after you have put up a few thousand yourself as an 

"advance fee". Other spam messages offer prescription drugs, without a prescription, at 

rock-bottom prices; software at prices that are too good to be true; messages claiming to be 

from friends, directing you to check out a specific web site; or e-mail offering you free 

pornography or miracle solutions to increase the size of certain body parts. 

 

While it is relatively simple to get rid of the junk mail you receive in your mailbox at home, 

spam is more difficult to detect. The subject headers of spam messages often lead you to 

think that the messages are from old friends or from businesses you have worked with. If 

you have to sort through all this spam in your in-box every day, especially if you need to 

read e-mail for your job, you'll waste a lot of time and be less productive. 
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Why Do You Receive Spam? 

While some spam seems to be personally addressed to you—it is sent to your address and 

uses your name—the majority of spam is sent automatically, by computer programs that 

ingest long lists of e-mail addresses and spit out millions of spam messages. The goal of 

spam is to benefit from large mailings, knowing that hardly anyone will respond to the 

messages' offers. A tiny percentage of replies to a small mailing of, say, several thousand 

addresses can be counted on the fingers of two hands, but when you send out tens of 

millions of messages, even a .001% response rate results in some impressive figures. 

 

Spammers "harvest" addresses in many ways: they use programs that search the web 

automatically looking for e-mail addresses, but also get them from newsgroups and mailing 

lists. If that isn't enough, they simply buy CD-ROMs that contain millions of addresses, 

including, perhaps, yours. Or they buy lists of e-mail addresses that have been submitted to 

web sites when users register or request information. In fact, if your e-mail address ends up 

anywhere on the Internet, there is a strong possibility that a spammer, somewhere, will find 

it.  

 

While you can avoid spam by not ever using your e-mail address on a mailing list or in a 

newsgroup, or never giving your e-mail address to a web site to register or ask for 

information, this defeats the purpose of the Internet. Many people see spam as unavoidable, 

as a natural side effect of the openness of the Internet. Unfortunately, this openness ends up 

filling your in-box with junk. 
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Why Use Intego Personal Antispam X3? 

Intego Personal Antispam X3 is the ultimate tool to fight spam for Mac OS X. Intego 

Personal Antispam X3 analyzes your incoming e-mail, determining which messages are 

spam and which are valid messages in many ways: by checking a whitelist of addresses, 

message content, message layout, URLs in messages, and much more.  

 

Unlike the spam filters provided with e-mail programs such as Apple Mail or Microsoft 

Entourage, Intego Personal Antispam X3 is intelligent. When you first install Intego 

Personal Antispam X3, its performance is similar to the filters included with e-mail 

programs, but as you use it more and more, having the program learn from your spam and 

from your good e-mail, Intego Personal Antispam X3 outperforms any spam filter 

available. 

 

Intego Personal Antispam X3 uses a set of plug-ins to provide the most powerful spam 

filter available. You choose which plug-ins you want to use, according to the type of spam 

you receive. Intego Personal Antispam X3 uses lexical filtering (also known as Bayesian 

analysis), attachment filters, whitelist and blacklist filters, and also filters URLs, using a 

database of known spam URLs that are often included in messages.  

 

You can even export your settings and spam database, after you have had Intego Personal 

Antispam X3 learn from your e-mail, and give it to friends, family or colleagues, so these 

people can get optimal spam filtering without having Intego Personal Antispam X3 learn 

from their e-mail. 

 

Spam techniques are constantly changing, and Intego Personal Antispam X3 offers monthly 

updates to fight new types of spam as they appear, and to update its database of spam 

URLs. 
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How Intego Personal Antispam X3 Works 

Intego Personal Antispam X3 helps weed out spam using a number of different techniques 

and filters, making it the most efficient anti-spam tool available for Mac OS X. In addition, 

some of the filters allow you to go even further and add your own rules and conditions, to 

weed out specific types of spam that you receive often. 

 

Since many techniques are used to send spam, and to attempt to fool programs that filter 

spam, Intego Personal Antispam X3 uses a full range of tools and filters to analyze your 

incoming e-mail. These filters make Intego Personal Antispam X3 the most powerful tool 

for combating spam, and help keep your in-box spam-free. 

 

Lexical Filtering 

Intego Personal Antispam X3 uses a powerful lexical filtering system, also known as 

Bayesian Analysis, to examine the words contained in your e-mail and determine which 

messages are valid and which are spam. The lexical filter is a statistic filter that determines 

whether incoming e-mail messages are spam or not. This filtering depends on a database 

installed with Intego Personal Antispam X3 and by how you have categorized e-mail 

messages that you have received. 

 

The lexical filter needs to learn which of your e-mail messages are spam and which are 

valid messages. You will be able to teach the filter using the Personal Antispam 

AppleScripts. This filter becomes more efficient as it learns from your e-mail. You must 

remember to teach it both what is spam and what is not to get the best results. 
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Blacklist and Whitelist 

Intego Personal Antispam X3 uses a blacklist and a whitelist to help filter spam. A blacklist 

is a list of addresses from which you receive spam. You can add addresses to the blacklist, 

to block any spam that is not detected by Intego Personal Antispam X3's filters, but that 

comes often from the same address. 

 

A whitelist is the opposite of a blacklist: it is a list of addresses whose messages are always 

accepted as valid. Intego Personal Antispam X3 offers several options to ensure that you 

don't get false positives: you can choose to always allow senders in Address Book, Apple's 

contact manager program, and the software that stores your addresses if you use Apple 

Mail. You can also have Intego Personal Antispam X3 add senders' addresses to the 

whitelist when you tell it to learn from good e-mail, ensuring that e-mail from your friends, 

co-workers and contacts goes straight into your in-box. 

 

URL Filter 

Intego Personal Antispam X3 has a URL filter that checks for certain URLs, and the way 

URLs appear in e-mail messages, to detect spam. Spammers often use techniques, such as 

displaying one URL but hiding a link to a different URL in a message, to fool recipients of 

their messages. E-mail with this type of URL is generally spam, and Intego Personal 

Antispam X3 searches for this, and other techniques, when analyzing your incoming e-

mail. 

 

Attachments 

Some spam can be detected by attachments, files sent together with messages, such as 

image files. Other messages may contain Windows viruses, which, while not exactly spam, 

can annoy you by filling your in-box. Intego Personal Antispam X3 checks for certain types 
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of attachments that may indicate spam, and also checks for .pif and .scr files, which are 

only sent with messages by Windows viruses. 



Chapter 2 – Installation  

 

 

Intego Personal Antispam X3 User's Manual Page 12 

 

 

 

 

 

 

 

 

 

 
 

 

2—Installation 



Chapter 2 – Installation  

 

 

Intego Personal Antispam X3 User's Manual Page 13 

 

System Requirements 

• Any officially-supported Mac OS X compatible computer  

• Apple Mail or Microsoft Entourage (X or 2004) e-mail program 

• Mac OS X 10.2 or higher, or Mac OS X Server 10.2 or higher 

• 20 MB free hard disk space 

 

Note: Intego Personal Antispam X3 is compatible with Mac OS X 10.3 Panther, and Mac 

OS X 10.2 Jaguar. 

 

Installing Intego Personal Antispam X3 

Installing Intego Personal Antispam X3 is very simple.  

 

If you have purchased Intego Personal Antispam X3 on a CD-ROM, insert the Intego 

Personal Antispam X3 CD-ROM in your computer's CD-ROM drive. Double-click the 

Software Mac OS X folder; a window opens, containing a series of folders, one for each 

language. Double-click the folder for your language, then double-click the Intego Software 

Install icon. 

 

 

The Intego Software Installer window displays. This installer allows you to install any of 

Intego's programs for Mac OS X, if you have serial numbers for the software, or to install 

demo versions of any of these programs. 
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To install Intego Personal Antispam X3, click the popup menu below Personal Antispam 

X3 and select Install. 

 

 

 

Click Launch Installation to begin installing Intego Personal Antispam X3. The Intego 

software license displays. Click Continue, then click Agree if you accept this license; if not, 

click Disagree, and the installer will quit. 
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The installer then asks if you want it to check Intego's web site to find out if more recent 

versions of the program are available. Click Check if you want to do this, or click Install 

Directly if you want to install the version on the CD-ROM. 

 

Skip ahead to The Intego Personal Antispam X3 Installer section of this chapter for the rest 

of the installation procedure. 
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If you have purchased Intego Personal Antispam X3 by download, you will have a disk 

image file, called Intego Personal Antispam X3.dmg. Double-click this file to open the disk 

image, which will mount on the desktop. A window opens, containing a series of folders, 

one for each language. Double-click the folder for your language, and you'll see the Intego 

Personal Antispam X3 installer, the Read me file, and the Intego Personal Antispam X3 

manual (this file). 

 

First, read the Read me file, for any late-breaking changes. Then, double-click the Intego 

Personal Antispam X3 installer. 

 

A window will present you with two options: Install and Uninstall. Click Install to install 

Intego Personal Antispam X3. If you ever need to uninstall the program, use the Uninstall 

button. 
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The Intego Personal Antispam X3 Installer 

After you launch the installation, with either the CD-ROM installer or the download 

installer, the following window displays: 

 

 

 

Click Continue to proceed with installation. The Intego software license displays. Click 

Continue, then click Agree if you accept this license; if not, click Disagree, and the installer 

will quit. 

 

The next window shows all the available disks or volumes on your computer. Select the 

disk or volume where you want to install Intego Personal Antispam X3, then click 

Continue. 
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Click Install to install Intego Personal Antispam X3. This performs a basic installation. You 

will see a window informing you that you must enter an administrator’s password to install 

Intego Personal Antispam X3. Enter your password in this dialog, then click OK. 

 

After installation, you will have to restart your computer. 
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Uninstalling Intego Personal Antispam X3  

If you ever want to uninstall Intego Personal Antispam X3, you can do so easily, depending 

on the way you purchased the software.  

 

If you purchased Intego Personal Antispam X3 on a CD-ROM, insert the Intego 

Personal Antispam X3 CD-ROM in your computer's CD-ROM drive. Double-click the 

Intego Software Install icon. Click the Uninstall icon on the installer, then check Personal 

Antispam X3. 

 

 

 

Click the Uninstall button to remove Intego Personal Antispam X3. 
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If you have purchased Intego Personal Antispam X3 by download, you will have a disk 

image file, called Intego Personal Antispam X3.dmg. Double-click this file to open the disk 

image, which will mount on the desktop. A window opens, containing a series of folders, 

one for each language. Double-click the folder for your language, and you'll see the Intego 

Personal Antispam X3 installer. 

 

A window will present you with two options: Install and Uninstall. Click the Uninstall 

button to remove Intego Personal Antispam X3. 
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Registering Intego Personal Antispam X3 

When you restart your computer, open Intego Personal Antispam X3—it is found in your 

Applications folder. Intego Personal Antispam X3 will open its Registration program, and 

display the following window: 

 

 

 

You must enter your name, company, if any, and your serial number. The serial number is 

found on a sticker on the Intego Personal Antispam X3 CD, or provided in the e-mail 

message confirming your purchase by download. When registration is completed, Intego 

Personal Antispam X3 will open and you can configure the program. 
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Using Intego Personal Antispam X3 in Evaluation Mode 

Intego Personal Antispam X3 offers an evaluation mode, to allow you to discover how it 

works before purchasing the program. If you have not yet registered the program, Intego 

Personal Antispam X3 displays its evaluation mode dialog when it starts up. 

 

  

 

To use Intego Personal Antispam X3 in evaluation mode, click Evaluation Mode when this 

dialog displays.  

 

When Intego Personal Antispam X3 runs in evaluation mode, it functions for 30 days. At 

the end of this period, you can either purchase a license for Intego Personal Antispam X3 or 

delete the program. 

 

You can find out how much time is left in your evaluation period by choosing About Intego 

Personal Antispam X3 from the Intego Personal Antispam X3 menu. The About screen tells 

you that the program is in evaluation mode, and shows the time remaining in evaluation 

mode. 
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If you wish to purchase a license for Intego Personal Antispam X3, click the Buy Now... 

button on the About window to go to the Intego web site. 
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Intego Personal Antispam X3's Setup Assistant 

When you first open Intego Personal Antispam X3, the program's Setup Assistant launches 

to help you quickly and easily configure Intego Personal Antispam X3 to work with your e-

mail program. Intego Personal Antispam X3 works with Apple Mail, the default e-mail 

program provided with Mac OS X, and Microsoft Entourage, the e-mail and personal 

information manager included with Microsoft Office.  
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The Intego Personal Antispam X3 Setup Assistant walks you through a series of steps to 

explain how the program works, and to configure it to work with your e-mail program: 

 

• Lexical Filtering 

• Other Filters 

• E-mail Programs 

• Conclusion 

 

Click the right arrow to begin configuring Intego Personal Antispam X3. You can click the 

left arrow at any time to return to previous screens. 

 

 

 

Note that Intego Personal Antispam X3 will not filter spam unless you configure it to work 

with your e-mail program, either Apple Mail or Microsoft Entourage. It will also not filter 

spam with any other e-mail programs. 
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Lexical Filtering 

This screen explains what lexical filtering is, and tells you how Intego Personal Antispam 

X3 uses this technique to filter your e-mail. 

 

 

 

As the text in the above screen explains, Intego Personal Antispam X3's filters become 

more efficient by learning from the actual e-mail that your receive. You must teach it to 

recognize both spam and good e-mail for it to be most effective. See Using Intego Personal 

Antispam X3 to find out how to teach Intego Personal Antispam X3 to recognize your e-

mail. 

 

Click the right arrow to go to the next screen. 
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Other Filters 

This tells you about the other types of filters that Intego Personal Antispam X3 uses to 

weed out spam.  

 

 

 

Click the right arrow to go to the next screen. 
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E-Mail Programs 

This screen asks you to choose which e-mail program(s) you use: you can choose Apple 

Mail, the default e-mail program provided with Mac OS X, Microsoft Entourage, the e-mail 

program and personal information manager included with Microsoft Office, or both, if you 

use both programs. 

 

 

 

Check the e-mail program(s) you use. 

 

Click the right arrow to go to the next screen. 
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Conclusion - Apple Mail 

This final screen configures Intego Personal Antispam X3 according to your choices. If you 

use Apple Mail, the Conclusion screen looks like this: 

 

 

 

Click the left arrow to return to any of the previous screens to make changes, or click 

Configure to configure Apple Mail for use with Intego Personal Antispam X3 and exit the 

assistant.  

 

Intego Personal Antispam X3 configures Apple Mail so it can filter incoming e-mail, then 

displays a dialog informing you that the configuration has been completed successfully. 
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Click OK, and the Intego Personal Antispam X3 Assistant exits, and the main Intego 

Personal Antispam X3 interface displays. 
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Conclusion - Microsoft Entourage 

If you use Microsoft Entourage, the following screen displays: 

 

 

 

You will have to perform some manual operations to configure Microsoft Entourage for use 

with Intego Personal Antispam X3. 

 

To help you configure Microsoft Entourage, an information panel will display in front of 

the Entourage window. Follow the instructions on this panel, and, when you have finished, 

click Done. 
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Click the left arrow to return to any of the previous screens to make changes, or click 

Configure to open Microsoft Entourage and display the information panel, so you can 

finish configuring Intego Personal Antispam X3. 

 

Intego Personal Antispam X3 opens Microsoft Entourage then displays the following 

screen: 

 

 

 

This screen remains in front of your Entourage window so you can see what steps you need 

to carry out. 
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First, you must turn off Entourage's built-in spam filter. Do the following: 

 

For Entourage v. X: 

 

1. In the Tools menu, select Junk Mail Filter. 

2. Uncheck the Enable Junk Mail Filter checkbox. 

3. Click OK to confirm your change. 
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For Entourage 2004: 

 

1. In the Tools menu, select Junk E-mail Protection. 

2. Click None to turn off the filter. 

3. Click OK to confirm your change. 
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When you have completed this, click Continue on the Intego Personal Antispam X3 

information panel. The second panel displays: 

 

 

 

You must now create a rule with Entourage so Intego Personal Antispam X3 can be 

activated and its filters can check your incoming e-mail. Do the following: 

 

1. In the Tools menu, select Rules. 

2. Click the tab related to the type of e-mail account you have. In most cases, this is 

Mail (POP), which is a standard dial-up account. If you have an IMAP, Hotmail or 

Exchange account, click the appropriate tab. If you have any doubts, ask your 

administrator or your ISP. 
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3. Click New to create a new rule. 

 

4. Name the new rule Personal Antispam. 

 

5. Click to the right of the first action in the Then section to select it, then click 

Remove Action to delete it. 

 

6. Remove the second action in the same way as above. 
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7. Click Add Action to create a new action. 

 

8. Click the Play Sound popup menu and select Run AppleScript. 

 

9. Click the Script button. A standard Select dialog displays. Go to your Documents 

folder and select the script named Personal Antispam.scpt. Click Select. The 

finished rule should look like this: 

 

10. Click OK to confirm the rule. 

 

When you have completed the above steps, click Done on the Intego Personal Antispam X3 

information panel.  
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Intego Personal Antispam X3 closes the assistant, then displays a dialog informing you that 

the configuration has been completed successfully. 

 

 

 

Click OK, and the Intego Personal Antispam X3 Assistant exits, and the main Intego 

Personal Antispam X3 interface displays. 

 

Position of the Personal Antispam Rule 

When Intego Personal Antispam X3 configures your e-mail program, it either creates a 

special rule (with Apple Mail) or tells you to create one manually (with Microsoft 

Entourage). These rules tell the e-mail programs to activate Intego Personal Antispam X3 

via an AppleScript so Intego Personal Antispam X3 can filter your incoming e-mail and 

check whether your messages are spam or good e-mail. 

 

The position of this rule can make a difference—not in the efficiency of Intego Personal 

Antispam X3's spam filter, but in the statistics you see in displayed in Intego Personal 

Antispam X3. 

 

If you place this rule at the end of the list (which is the default position), any other rules 

you may have set up will filter your messages before Intego Personal Antispam X3 gets to 

see them. These rules will filter some messages—in most cases, valid e-mail messages—
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and either move them into specific folders, change their categories, or perform other 

actions. If the rules say that no further actions are not to be performed, Intego Personal 

Antispam X3 will have fewer messages to filter. 

 

If, however, you place the Personal Antispam rule at the beginning of your list of rules, all 

your messages will get filtered first by Intego Personal Antispam X3, then by your specific 

rules. Again, this does not change the efficiency of Intego Personal Antispam X3, but it will 

result in a higher number of messages being shown as analyzed in the Intego Personal 

Antispam X3 statistics. 

 

Note that if you use Microsoft Entourage, and have mailing list information in the Mailing 

List Manager, these messages are sorted before any other rules, and will not be analyzed 

nor counted by Intego Personal Antispam X3. 
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Configuring Intego Personal Antispam X3 for Multiple Users 

You can use Intego Personal Antispam X3 with as many user accounts as are on your 

Macintosh computer. However, since each user has different settings for their e-mail 

program, and may use a different program (one user may prefer Apple Mail and another 

may use Microsoft Entourage), you must configure Intego Personal Antispam X3 for each 

user who wishes to benefit from its functions. 

 

To do this, log out of the current account by selecting the Apple menu > Log out [User 

name], then log in to a different user account. Launch Intego Personal Antispam X3, which 

is located in the Applications folder, and the configuration assistant will open 

automatically. Follow the same procedure as that described earlier in this chapter to 

configure the user's e-mail program(s), and repeat this for all user accounts that will use 

Intego Personal Antispam X3. 
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Using Intego Personal Antispam X3  

After you have configured Intego Personal Antispam X3 with the Setup Assistant, Intego 

Personal Antispam X3 opens and displays its main interface. You won't need to have Intego 

Personal Antispam X3 open, however, for it to filter your e-mail. You only need to open 

the Intego Personal Antispam X3 application when you want to change its preferences or 

settings. (See Chapter 5, Intego Personal Antispam X3 Settings and Preferences.) 

 

 

 

Unless you want to change some of Intego Personal Antispam X3's settings, you can quit 

the program. 
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Using Intego Personal Antispam X3 with Apple Mail 

After you have installed Intego Personal Antispam X3 and configured it to work with 

Apple Mail, Intego Personal Antispam X3 will begin filtering your incoming e-mail the 

next time Mail receives messages. Intego Personal Antispam X3 works in the background, 

so you don't have to do anything for it to separate your good e-mail from the spam you 

receive. 

 

Intego Personal Antispam X3 adds a Spam folder to Mail's mailbox list.   

 

 

 

When Intego Personal Antispam X3 determines that one of your incoming messages is 

spam, it moves the message to the Spam folder. Messages that Intego Personal Antispam 

X3 determines are good e-mail go into your in-box, unless you have created rules to filter 

then into other mailboxes or folders. 

 

You should still check the Spam folder before deleting the messages it contains; it is 

possible that one or several false positives, or valid e-mail messages that get marked as 

spam, may be in this folder. 
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Using Intego Personal Antispam X3 with Microsoft Entourage 

After you have installed Intego Personal Antispam X3 and configured it to work with 

Microsoft Entourage, Intego Personal Antispam X3 will begin filtering your incoming e-

mail the next time Entourage receives messages. Intego Personal Antispam X3 works in the 

background, so you don't have to do anything for it to separate your good e-mail from the 

spam you receive. 

 

Intego Personal Antispam X3 adds a Spam folder to Entourage's folder list.   

 

 

 

When Intego Personal Antispam X3 determines that one of your incoming messages is 

spam, it marks the message as junk mail and moves it to the Spam folder. Messages that 

Intego Personal Antispam X3 determines are good e-mail go into your in-box, unless you 

have created rules to filter then into other mailboxes or folders. 

 

You should still check the Spam folder before deleting the messages it contains; it is 

possible that one or several false positives, or valid e-mail messages that get marked as 

spam, may be in this folder. 
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Helping Intego Personal Antispam X3 Learn from Your E-Mail 

While Intego Personal Antispam X3 is very effective at separating spam from good e-mail, 

the e-mail you get is different from everyone else's. When you first start using Intego 

Personal Antispam X3 you'll find that some spam will still end up in your in-box, and some 

good e-mail might get filed in the Spam folder. 

 

Intego Personal Antispam X3 is an intelligent spam-filtering program, and it can learn from 

the e-mail you receive. When you discover spam in your in-box, or good e-mail in the 

Spam folder, you can use Intego Personal Antispam X3's special training scripts to help the 

program work more efficiently. Intego Personal Antispam X3 performs optimally after a 

few weeks of this training. 

 

Intego Personal Antispam X3 uses AppleScripts to do this. AppleScript is a technology that 

is part of Mac OS X, and that can extend the functionality of certain programs. Apple Mail 

and Microsoft Entourage each have a special script menu that contains AppleScripts.  

 

You'll see the script menu in the Mail menu bar, between the Window and Help menus: 

 

 

 

With Entourage, the script menu is to the right of the Help menu: 

 

 

 

As you can see in both examples above, the AppleScript menu is the scroll icon. Click this 

icon and you'll see a menu of all the AppleScripts available for Mail or Entourage. 
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Learning Spam 

To tell Intego Personal Antispam X3 to learn from spam that is in your in-box, select one or 

several spam messages, then click the AppleScript icon and select Personal Antispam > 

Learn Spam. This tells Intego Personal Antispam X3 to analyze the messages and add the 

words they contain, and other characteristics, to its lexical filter. 

 

In addition to adding the words contained in the messages to the lexical filter, this tells 

Intego Personal Antispam X3 to add the sender to the blacklist (if you have checked Add 

Sender to Blacklist when Learning in the Blacklist settings). 

 

This is what you'll see with Apple Mail: 
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You can either select one of the scripts from the Personal Antispam sub-menu, or you can 

use keyboard shortcuts to run the scripts without using the menu. To run the Learn Good E-

mail script, press Control-Shift-G. To run the Learn Spam script, press Control-Shift-S. 

 

If you use Microsoft Entourage, you'll see this: 

 

 

 

You can either select one of the scripts from the Personal Antispam sub-menu, or you can 

use keyboard shortcuts to run the scripts without using the menu. To run the Learn Good E-

mail script, press Control-Shift-G. To run the Learn Spam script, press Control-Shift-S. 

 

In either case, your script menu might look different, especially if you have added your 

own AppleScripts to this menu. 
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Learning Good E-Mail 

To tell Intego Personal Antispam X3 to learn from good e-mail messages that were moved 

to the Spam folder, select one or several messages, then click the AppleScript icon and 

select Personal Antispam > Learn Good E-mail. In addition to adding the words contained 

in the messages to the lexical filter, this tells Intego Personal Antispam X3 to add the 

sender to the whitelist (if you have checked Add Sender to Whitelist when Learning in the 

Whitelist settings). 

 

You can find out more about the settings for the whitelist and other filters later in this 

chapter, in Intego Personal Antispam X3 Preferences and Settings. 
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Optimizing Intego Personal Antispam X3 Spam Filtering 

As mentioned in the previous section, you should use the AppleScripts available from your 

e-mail program to help Intego Personal Antispam X3 learn your e-mail and the spam you 

receive. Since the e-mail and spam you receive is unique, this helps ensure that Intego 

Personal Antispam X3's spam filtering is optimal.  

 

To best optimize Intego Personal Antispam X3's filtering, you should teach it the 

following: 

 

• Spam that goes in your in-box: you should use the Learn Spam AppleScript for all 

spam that goes into your in-box. This adds the words and other characteristics of 

these messages to Intego Personal Antispam X3's filters, and helps ensure that 

Intego Personal Antispam X3 is as effective as possible. As time goes by, you 

should see little or no spam in your in-box as Intego Personal Antispam X3 learns 

from your e-mail. 

• Good e-mail that gets filed in the Spam folder: when good e-mail gets mistakenly 

filed in your Spam folder, this is called a false positive. Whenever you find a false 

positive in your Spam folder, use the Learn Good E-mail AppleScript to add its 

contents to Intego Personal Antispam X3's filters. As time goes by, you should see 

few or no false positives in your Spam folder as Intego Personal Antispam X3 

learns from your e-mail. 

• Good e-mail messages: for the first week or so, train Intego Personal Antispam X3 

by selecting good e-mail messages and using the Learn Good E-mail AppleScript. 

This helps Intego Personal Antispam X3 recognize the type of e-mail you receive. 

Ideally, you should do this for several hundred messages, so, depending on how 

much e-mail you receive, you may want to do this for as little as a few days or as 

many as several weeks. 



Chapter 4 — Using Intego Personal Antispam X3  

 

 

Intego Personal Antispam X3 User's Manual Page 51 

 

The more you train Intego Personal Antispam X3 and help it learn from your e-mail, using 

the techniques above, the more efficient it will become. Eventually, you'll find that all your 

spam goes into your Spam folder, and that all your good e-mail goes into your in-box, or 

other folders, if you use rules to sort your messages. 
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Tips for Dealing with Spam 

While Intego Personal Antispam X3 filters your e-mail and weeds out spam, moving it to a 

Spam folder, it cannot stop the arrival of these messages to your e-mail account. There are a 

few things you should keep in mind when dealing with spam—while these tips won't stop 

spam, they may keep you from receiving more spam. 

 

• Don't ever reply to spam: if you reply to a spam message, even requesting that the 

sender stop sending you messages, it is not likely to do any good. At best, your 

message will bounce, since spammers often forge the From address in their 

messages. At worst, it will tell the spammer that yours is a valid address, and could 

lead to your receiving even more spam as your address gets sold or traded to other 

spammers. 

• Don't even click a link in a spam message: as above, clicking a link confirms that 

your address is valid. Don't even click links that say they will unsubscribe you from 

a mailing list, unless you are sure that the message in question is indeed from a 

mailing list, and not a mass-mailed spam message. 

• Don't open attachments: attachments can contain viruses. Don't open attachments 

unless you are sure they are from someone you know and trust. Even then, don't 

open an attachment unless you were expecting to receive it; many viruses send 

attachments with messages from people you know, along with brief text messages. 

• Turn off HTML display: spammers use web bugs, or tiny graphics in their 

messages, to check whether recipients view these messages. When you use HTML 

display in your e-mail program, the program must connect to the web site 

containing the graphic to display the message, thus telling the spammer that you 

have seen the message, and that your address is valid. 
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Overview 

When you open Intego Personal Antispam X3, the program displays its overview screen. 

This screen shows you statistics about your e-mail and spam, lets you change some general 

settings, and lets you turn antispam protection on or off. 
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Antispam Protection 

By default, Intego Personal Antispam X3's antispam protection is on, but you may, for 

some reasons, want to turn it off temporarily. To do this, check Inactive on the main screen. 

 

 

 

Don't forget to turn this protection back on when you want it to filter your spam again—just 

click the Active button to do this. 

 

Other Intego Personal Antispam X3 Settings 

Intego Personal Antispam X3 offers two settings that allow you to control the way the 

program displays. Intego Personal Antispam X3 offers a monitoring window that displays 

above all your other programs. This window tells you when Intego Personal Antispam X3 

has detected spam in your incoming e-mail, even if your e-mail program is in the 

background.  A similar window displays when you activate Intego Personal Antispam X3's 

AppleScripts to tell the program to learn from your e-mail. 
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By default, this monitoring window is activated. If you wish to turn it of, check Disabled. 

You can always turn it on again by checking Enabled. 

 

 

 

Intego Personal Antispam X3 lets you choose from two interfaces: the standard Aqua 

interface, or a Brushed Metal Interface. By default, the Aqua interface is used. If you wish 

to use the Brushed Metal interface, check the Brushed Metal radio button.  

 

 
 

The Brushed Metal interface looks like this: 
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Viewing Antispam Statistics 

As you can see on the Overview tab, Intego Personal Antispam X3 shows you a cumulative 

total of the number of e-mail messages the program has analyzed since you installed the 

program, the number of good e-mails detected, the number of spams detected and the 

number of e-mails incorrectly identified. 

 

For e-mails incorrectly identified, or false positives, Intego Personal Antispam X3 only 

knows that these are good e-mail messages if you select the messages and run the Learn 

Good E-mail AppleScript. For more on this, see Helping Intego Personal Antispam X3 

Learn from Your E-Mail in Chapter 4 of this manual. 

 

 

 

Note: the number of e-mail messages shown as analyzed in the different statistic graphs 

depend, in part, on the position of the Personal Antispam rule in your e-mail program's list 

of rules. See Chapter 3, Position of the Personal Antispam Rule, for more on choosing the 

appropriate position for this rule. 
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Intego Personal Antispam X3 also displays a graph of e-mails analyzed and spams detected. 

You can choose from three displays for this graph: the last 24 hours, the last 7 days, and the 

last 30 days. To change the display, click the popup menu showing the display range and 

choose a new range. 

 

 

 

Intego Personal Antispam X3 uses the same type of graph for each individual filter. To 

view these statistics, click one of the filter icons in the Intego Personal Antispam X3 

toolbar, then click the Statistics disclosure triangle. 
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You can show or hide the statistics for each individual filter in this way. 

 

Note: Statistics for the different filters will show a different number of e-mails analyzed for 

each filter. When one of Intego Personal Antispam X3's filters detects a good message or a 

spam message, other filters may not examine it. Intego Personal Antispam X3's filters 

examine your e-mail in the following order:  

 

• Attachment filter 

• URL filter 

• Whitelist 

• Blacklist 

• Lexical filter 

 

It is therefore normal that you see different numbers of e-mails analyzed for each of these 

filters, and for the overall number of messages. 
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Lexical Filter Settings 

Intego Personal Antispam X3 uses a powerful lexical filtering system, also known as 

Bayesian Analysis, to examine the words contained in your e-mail and determine which 

messages are valid and which are spam. The lexical filter is a statistic filter that determines 

whether incoming e-mail messages are spam or not. This filtering depends on a database 

installed with Intego Personal Antispam X3 and by how you have categorized e-mail 

messages that you have received. 

 

To view settings for the lexical filter, click the Lexical icon at the top of the Intego Personal 

Antispam X3 window. 
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If, for any reason, you want to turn off the lexical filter, click Inactive at the top of the 

window. To turn the filter on again, click Active. 

 

Viewing Lexical Filter Statistics 

To view statistics for this filter, click the Statistics disclosure triangle. This displays a 

statistics graph. See Viewing Antispam Statistics earlier in this manual for more on 

displaying statistics. 

 

 

 

Managing the Lexical Filter 

The lexical filter tab shows you all the words that Intego Personal Antispam X3 has added 

to its lexical database. You can examine these words to see how often they appear in good 

e-mail messages or in spam as well as the last date and time that they were seen.  

 

Words only get added to the lexical filter database when you use Intego Personal Antispam 

X3's AppleScripts to learn good e-mail or learn spam. The more messages you teach Intego 

Personal Antispam X3, the more efficient its lexical filter becomes. 
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If you want to remove any words from the database, click a word to select it, or select 

several words by clicking a first word, holding down the Command key, then clicking 

another word, then click Remove. An alert will ask you if you really want to remove all the 

words—you cannot undo this action. If you do want to remove these words, click Yes; if 

not click Cancel. 

 

 

 

If you want to empty the entire database, click Remove All. An alert will ask you if you 

really want to remove all the words—you cannot undo this action. If you do want to empty 

the database, click Yes; if not click Cancel. 

 

You can tell Intego Personal Antispam X3 to optimize the lexical filter database weekly. If 

you do this, Intego Personal Antispam X3 examines the lexical filter database once a week 

and removes words that have not been seen frequently or recently. This improves the speed 

of the lexical filter and improves overall performance. To set this option, check Optimize 

Dictionary Weekly. 
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Blacklist Filter Settings 

Intego Personal Antispam X3 uses a blacklist and a whitelist to help filter spam. A blacklist 

is a list of addresses from which you receive spam. You can add addresses to the blacklist, 

to block any spam that is not detected by Intego Personal Antispam X3's filters but that 

comes often from the same address. 

 

The blacklist filter also allows you to add specific strings that Intego Personal Antispam X3 

will search for in message headers such as the subject, the From or To headers, and more. 

You can set precise filters for most message headers, allowing you to filter specific types of 

spam that you receive often. 

 

To view settings for the blacklist filter, click the Blacklist icon at the top of the Intego 

Personal Antispam X3 window. 
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If, for any reason, you want to turn off the blacklist filter, click Inactive at the top of the 

window. To turn the filter on again, click Active. 

 

Viewing Blacklist Filter Statistics 

To view statistics for this filter, the Statistics disclosure triangle. This displays a statistics 

graph. See Viewing Antispam Statistics earlier in this manual for more on displaying 

statistics. 

 

 

 

Blacklist Filter Options 

The blacklist filter offers one option to help Intego Personal Antispam X3 fight spam more 

efficiently. If you check Add Sender to Blacklist when Learning, Intego Personal Antispam 

X3 adds the From address, in every e-mail message you tell the program to learn as spam, 

to the blacklist.  This marks all future messages from these senders as spam automatically. 
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Adding Items to the Blacklist Filter 

The blacklist filter is empty when you first start using Intego Personal Antispam X3, but 

you can add your own entries to this filter. To do this, click New. Intego Personal Antispam 

X3 adds a new line to the filter list. 

 

 

 

There are three fields in this filter list: Object, Comparator and Pattern.  

 

In the Object field, you can select from a number of e-mail message headers. Click the 

From cell and a popup menu displays: 

 

 

 

Select the header you want the filter to search for. 
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The Comparator field lets you select how Intego Personal Antispam X3 is to match the 

selected header. Click the Starts With cell and a popup menu displays: 

 

 

 

Select the comparator you want the filter to use. 

 

Finally, enter a text or regular expression in the Pattern field. 

 

 

 

Intego Personal Antispam X3 will mark as spam any messages that match items you have 

added to the blacklist filter in this manner. 

 

Removing Items from the Blacklist Filter 

If you want to remove any items from this filter, click an item to select it, or select several 

items by clicking a first item, holding down the Command key, then clicking another item, 

then click Remove. An alert will ask you if you really want to remove all the items—you 

cannot undo this action. If you do want to remove these items, click Yes; if not click 

Cancel. 
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Whitelist Filter Settings 

A whitelist is the opposite of a blacklist: it is a list of addresses whose messages are always 

accepted as valid. Intego Personal Antispam X3 offers several options to ensure that you 

don't get false positives: you can choose to always allow senders in Address Book, Apple's 

contact manager program and the software that stores your addresses if you use Apple 

Mail. You can also have Intego Personal Antispam X3 add senders' addresses to the 

whitelist when you tell it to learn from good e-mail, ensuring that e-mail from your friends, 

co-workers and contacts goes straight into your in-box. 

 

To view settings for the whitelist filter, click the Whitelist icon at the top of the Intego 

Personal Antispam X3 window. 
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If, for any reason, you want to turn off the whitelist filter, click Inactive at the top of the 

window. To turn the filter on again, click Active. 

 

Viewing Whitelist Filter Statistics 

To view statistics for this filter, the Statistics disclosure triangle. This displays a statistics 

graph. See Viewing Antispam Statistics earlier in this manual for more on displaying 

statistics. 

 

 

 

Whitelist Filter Options 

The whitelist filter offers two options to help Intego Personal Antispam X3 function 

optimally. If you check Allow senders in Address Book, Intego Personal Antispam X3 adds 

all the contacts in Apple's Address Book to the whitelist as valid senders, and will never 

mark messages from any of these contacts as spam. 
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(Note: the whitelist filter does not recognize contacts stored in Microsoft Entourage.) 

 

If you check Add sender to Whitelist when learning, Intego Personal Antispam X3 adds the 

senders of good e-mail messages to the whitelist when you use the Learn Good E-mail 

AppleScript. This ensures that messages from these senders will never be marked as spam. 
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Adding Items to the Whitelist Filter 

The whitelist filter is empty when you first start using Intego Personal Antispam X3, but 

you can add your own entries to this filter. To do this, click New. Intego Personal Antispam 

X3 adds a new line to the filter list. 

 

 

 

There are three fields in this filter list: Object, Comparator and Pattern.  

 

In the Object field, you can select from a number of e-mail message headers. Click the 

From cell and a popup menu displays: 

 

 

 

Select the header you want the filter to search for. 
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The Comparator field lets you select how Intego Personal Antispam X3 is to match the 

selected header. Click the Starts With cell and a popup menu displays: 

 

 

 

Select the comparator you want the filter to use. 

 

Finally, enter a text or regular expression in the Pattern field. 

 

 

 

Intego Personal Antispam X3 will mark as good e-mail any messages that match items you 

have added to the whitelist filter in this manner. 

 

Removing Items from the Whitelist Filter 

If you want to remove any items from this filter, click an item to select it, or select several 

items by clicking a first item, holding down the Command key, then clicking another item, 

then click Remove. An alert will ask you if you really want to remove all the items—you 

cannot undo this action. If you do want to remove these items, click Yes; if not click 

Cancel. 
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URL Filter Settings 

Intego Personal Antispam X3 has a URL filter that checks for certain URLs, and the way 

URLs appear in e-mail messages, to detect spam. Spammers often use techniques, such as 

displaying one URL but hiding a link to a different URL in a message, to fool recipients of 

their messages. E-mail with this type of URL is generally spam, and Intego Personal 

Antispam X3 searches for this, and other techniques, when analyzing your incoming e-

mail. 

 

In addition, Intego Personal Antispam X3 uses a special database of URLs that are known 

to be used in spam messages. This database is included with Intego Personal Antispam X3, 

and monthly updates help ensure that Intego Personal Antispam X3 weeds out the latest 

spam. Intego monitors spam that is sent over the Internet and records URLs that are used in 

spam messages, and the monthly updates to this database help ensure that your in-box 

remains spam-free. 

 

To view settings for the URL filter, click the URL icon at the top of the Intego Personal 

Antispam X3 window. 
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If, for any reason, you want to turn off the URL filter, click Inactive at the top of the 

window. To turn the filter on again, click Active. 

 

Viewing URL Filter Statistics 

To view statistics for this filter, the Statistics disclosure triangle. This displays a statistics 

graph. See Viewing Antispam Statistics earlier in this manual for more on displaying 

statistics. 
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URL Filter Subscriptions and Updates 

The URL Filter tab shows you the version of Intego Personal Antispam X3 you have 

installed, the last time you checked for updates to URL filters, and your subscription limit. 

When you purchase Intego Personal Antispam X3, you have access to updates and updated 

URL filters for one year from the date of purchase. After this time, additional subscriptions, 

allowing you to extend your access to updated URL filters, are available from Intego, and 

can be purchased either from the Intego web site (www.intego.com) or through NetUpdate.  

 

See the section on NetUpdate later in this manual for more. 
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Attachment Filter Settings 

Some spam can be detected by attachments, files sent together with messages, such as 

image files. Other messages may contain Windows viruses, which, while not exactly spam, 

can annoy you by filling your in-box. Intego Personal Antispam X3 checks for certain types 

of attachments that may indicate spam, and also checks for .pif and .scr files, which are 

only sent with messages by Windows viruses. 

 

To view settings for the attachment filter, click the Attachment icon at the top of the Intego 

Personal Antispam X3 window. 

 

 

 

If, for any reason, you want to turn off the attachment filter, click Inactive at the top of the 

window. To turn the filter on again, click Active. 
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Viewing Attachment Filter Statistics 

To view statistics for this filter, the Statistics disclosure triangle. This displays a statistics 

graph. See Viewing Antispam Statistics earlier in this manual for more on displaying 

statistics. 

 

 

 

Adding Items to the Attachment Filter 

The attachment filter automatically checks for certain types of attachments, but you can 

also add your own items to the list. To do this, click New. Intego Personal Antispam X3 

adds a new line to the filter list. 

 

 

 

There are three fields in this filter list: Object, Comparator and Pattern.  

 

The Object field for this filter contains Attachment Name; you cannot change this. 
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The Comparator field lets you select how Intego Personal Antispam X3 is to match the 

selected header. Click the Starts With cell and a popup menu displays: 

 

 

 

Select the comparator you want the filter to use. 

 

Finally, enter a text or regular expression in the Pattern field. 

 

 

 

Intego Personal Antispam X3 will mark as spam any messages that match items you have 

added to the attachment filter in this manner. 
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Removing Items from the Attachment Filter 

If you want to remove any items from this filter, click an item to select it, or select several 

items by clicking a first item, holding down the Command key, then clicking another item, 

then click Remove. An alert will ask you if you really want to remove all the items—you 

cannot undo this action. If you do want to remove these items, click Yes; if not click 

Cancel. 
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Running the Intego Personal Antispam X3 Setup 
Assistant 

When you first configured Intego Personal Antispam X3, the program's setup assistant 

helped you configure your e-mail program, either Apple Mail or Microsoft Entourage. If 

you need to configure a different e-mail program, you can run the setup assistant again at 

any time. 

 

To do this, just click the Assistant icon in the Intego Personal Antispam X3 window 

toolbar. 

 

 

 

See Chapter 3 of this manual, Configuring Intego Personal Antispam X3, for more on using 

this assistant and configuring your e-mail program. 
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Exporting Settings 

You can save all your Intego Personal Antispam X3 settings, and its spam database, in a 

special file that you can then use to import these settings into another copy of Intego 

Personal Antispam X3. This is especially useful if you manage many computers and want 

to use the same settings and database for all of them, or if you want to share your database 

with friends, family or colleagues. 

 

To export your settings, select File > Export Settings... A dialog box asks you to name the 

settings file and choose a location to save it. Make sure not to change the .antispam file 

extension on the settings file after you have saved it. 

 

Importing Settings 

If you have exported settings from one copy of Intego Personal Antispam X3 (see above) 

you can import them into another copy of the program. 

 

To import settings, you can simply double-click the .antispam settings file that you 

exported from another copy of Intego Personal Antispam X3. This opens Intego Personal 

Antispam X3, which asks if you are sure that you want to replace the current settings and 

database with those you are importing.  

 

You can also select File > Import Settings... A file dialog asks you to locate the settings 

file. Click Import and these settings are immediately applied to Intego Personal Antispam 

X3. 
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NetUpdate 

NetUpdate is an application that Intego's programs can use to check if the program has been 

updated. This application is installed at the same time as Intego Personal Antispam X3 or 

other Intego programs. It checks updates for all of these programs at the same time, and 

downloads and installs those for the programs installed on your computer. 

 

 

The NetUpdate tab gives you information on your installed version, the last time 

NetUpdate checked Intego's server for updates, and your subscription limit. To check for 

updates, click Check now... NetUpdate will open and check for updates. 

 

For more on using NetUpdate, see the NetUpdate User's Manual. 
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Technical support is available for registered purchasers of Intego Personal Antispam X3. 

 

 

 

By e-mail 

support@intego.com 

 

From the Intego web site 

www.intego.com 

 

 
 
 
 
 
 
 
 
 
 

 

 

 

 

 

 

 

 

 



Chapter 7—Glossary 

 

 

Intego Personal Antispam X3 User's Manual Page 84 

 

 

 

 

 

 

 

 

 

 

7—Glossary 

 



Chapter 7—Glossary 

 

 

Intego Personal Antispam X3 User's Manual Page 85 

 

Bayesian analysis: This is a statistic method used to determine whether incoming e-mail 

messages are spam or not. This analysis uses a database of good and bad words, and 

weights the resulting analysis of each message according to the frequency of each type of 

word. 

Blacklist: This is a list of bad addresses, from which all messages are considered to be 

spam. 

False positive: This is a valid e-mail message that gets sorted as spam. 

Mailing list: A mailing list is a type of forum that operates via e-mail. After you subscribe 

to a mailing list, you receive all the messages sent to the list by all the subscribers.  Other 

mailing lists are one-way lists, or announcement lists, where you receive newsletters or 

other types of information but cannot send your own messages to the list. Sometimes 

people subscribe your address to a mailing list without your permission, and you may 

receive a flood of messages until you unsubscribe. 

Rule: E-mail programs use rules to sort messages. Intego Personal Antispam X3 uses rules 

to activate its filtering engine, but you may also have rules set for your e-mail program to 

sort mail from friends, colleagues, customers or mailing lists into special folders. 

Spam: Unwanted e-mail messages, usually sent to thousands, even millions of people at a 

time, with a goal of selling products or services. Also called unsolicited commercial e-mail, 

or junk mail. 

URL: Uniform Resource Locator, or link. The most common URLs are links to web sites. 

Whitelist: This is a list of good addresses, usually those of your contacts, from which all 

messages are considered to not be spam. 

 


